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    Introducing Ortelia Curator 
 

 

Ortelia Curator™ is a 3D interactive tool for designing exhibitions. It assists curators and designers in the 
decision-making and creative process encouraging users to develop a more profound understanding of 
the exhibition design process and its relationship to space. 

Ortelia Curator™ has been created specifically with gallery designers, curators, and educators in mind. 
Ortelia Curator™ enables users to accurately design real or imaginary exhibitions in their own gallery as 
well as to custom build gallery spaces. 

Users can test their ideas before handling artwork; an exhibition can be saved for later editing. Using 
this application curators and designers can share their ideas and work with peers. Ortelia Curator™ 
significantly reduces artwork handling and the time it takes to design an exhibition. Designers can 
experiment with multiple design concepts rapidly while facilitating the creative process. 
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System Requirements 
 
The following hardware and software configurations are recommended for running Ortelia Curator. 

Operating system: 

• Microsoft Windows XP® (SP3), Vista®, Windows 7®, Windows 10® 

• Macintosh OSX 

• Linux operating systems not supported. 

Hardware: 

• Recommended minimum of 4Gb of RAM 

• Intel Core 2 Duo or Quad Core processor or above 

• DirectX 9.0c (and above) capable graphics card with a minimum of 512Mb graphics memory (we 
recommend Nvidia graphics cards, see below)  

 
Important Note 

Ortelia Curator leverages many of the latest developments in graphics card technology. Specifically, the interactive 
environment utilizes Microsoft DirectX  Shaders (Shader Model 3 support and above). Your graphics card (at a 
minimum) must support Microsoft DirectX 9c and above to ensure that your environment will display correctly. The 
following graphics cards are a minimum specification required to run Ortelia Curator.  
  
 

Minimum Graphics card specification 
 
ATI Radeon HD 3800 Series. and above - 512Mb Memory and above 
NVIDIA GeForce 8 Series and above - 512Mb Memory and above 
 
Note: We do not recommend the use of integrated motherboard graphics cards. It is highly recommended that a 
stand-alone graphics card be used. 

  

http://www.nvidia.com/content/global/global.php
http://www.microsoft.com/games/en-US/aboutGFW/pages/directx.aspx
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Getting Started 
 

Installing Ortelia Curator™ (Microsoft Windows OS) 
Important Note: It is highly recommended that you have Administrator privileges when installing 
Ortelia Curator 

Locate CuratorSetup.exe.  Run the file by double clicking it using the Left Mouse Button. It is 
recommended that you exit all your other running programs.  

 

When you run the setup file you will see the following 
window. 

 

(Windows Vista / Windows 7) You may see a User 
Account Control message. In this case, allow the setup to 

run by clicking Yes. 

 

 

The following screen will be the License Agreement. You 
will need to click ‘I Agree’ in order to proceed with the 

installation of the software. 
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Following the component selection screen you can 
choose the destination folder you would like to install to. 

You can choose the default location or a destination of 
your choice. Once you have chosen your destination click 

‘Install’. 

 

 

 

The Ortelia Curator Installation will begin. 

 

 

When the installation completes click ‘Finish’ to close the 
installation window. 

 

After you have installed Ortelia Curator you can start it by accessing the ‘Ortelia Curator’ menu in the 
windows Start menu or the desktop shortcut.  
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Installing Ortelia Curator™ (Macintosh OSX) 
Important Note: It is highly recommended that you have Administrator privileges when installing 
Ortelia Curator 

• Locate OrteliaCurator.dmg which usually ends up in your Desktop or Downloads 

• Double-click the OrteliaCurator.dmg file and follow the procedure below. 

• When completed Ortelia Curator will be available in your Applications folder 

 

Double click the ‘Ortelia Curator.pkg’ icon 

 

The Installer information screen will appear. Click 
‘Continue’ 

 

The License Agreement window will appear. Click on 
‘Continue’ if you agree with the license agreement. 
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The information window will appear detailing the space 
required. You can also choose to install to a directory 
other than the default.  

 

You may be required to enter your computer username 
and password to proceed.  

 

If the installation is successful this window will appear. 
You are now ready to activate your software. 
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Activating and Deactivating Ortelia Curator 
 
When you purchased Ortelia Curator you were issued with a license number and password. 
 
Important Note: Keep your license number and password in a secure location as you will need them if 
you deactivate your license on one computer and re-activate it on another. 
 
In order to use Ortelia Curator you will need to activate your license. The first time you start Ortelia 
Curator you will be prompted to activate the license.  
 
Note: You will require an Internet connection in order to activate your license. 
 

• Be sure to have your license number and supplied password ready. 

• Activation is a one-time only operation unless you choose to deactivate your license on a 
specific computer and reactivate it on another. 

 
The first time you start Ortelia Curator the screen shown here 
will appear asking you to activate your new license. 
 
 
 
 
 
 
 
 
 
 

 
Follow the procedure outlined below to activate your license on-line.  
 

 

 

1. Click on 'Activate Ortelia Curator'  
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2. Enter the supplied License ID and password and click 
'Continue 

3. Ortelia Curator will communicate with the licensing 
server. 

 

 

4. If you license and password are valid you will see  
'Activation Successful'. Click 'Continue' to start Ortelia 
Curator 

 

Should you wish to transfer your license to another computer you will first need to deactivate the 
license on your current computer and then reactivate on another that has Ortelia Curator installed. 

 (There is no limit to the number of time you can activate and deactivate a license) 

To deactivate your license, go to the Help menu in Ortelia Curator. 

I. Click on 'Deactivate License' 

II. A dialogue box will appear prompting you verify deactivation. 

III. Once the license is successfully deactivated you will receive a 

confirmation dialogue. 

You can now follow the activation procedure outlined above to reactivate the license. 

Important Note: If you uninstall Ortelia Curator be sure to deactivate your license beforehand. Failure 

to do so will leave your license activated and you will not be able to transfer it to another computer.  



 

Ortelia Interactive Spaces Copyright 2017 
 

11 

The Ortelia Curator Interface 
To start Ortelia Curator™ go to the Windows start menu and navigate to the Ortelia Curator menu. 
Click on the Ortelia Curator link and click with your Left Mouse Button (LMB). 

 

Note: Load time will depend on the hardware configuration you are using. Refer to our recommended hardware 

configuration above.  

Upon loading you will be placed inside the default gallery or last gallery you used.  The 'Curate' work 
panel will also be visible. There are three key areas within the environment. These are: 

I. The File Menus 

II. The Curate Work Panel 

III. The Gallery Work Space 

 

 

The Ortelia Curator Interface 

The File Menus 
The 'File' menu consists of four menu items with each menu having its own drop-down. The menu items 
and their drop-downs are detailed below.    

  

The 'Curate' work 
panel 

(The panel can be hidden 
by clicking this tab with 

the LMB) 

Gallery Work Space 

File menus 

file:///D:/Ortelia/Docs/MayneControls/system-requirements
file:///D:/Ortelia/Docs/MayneControls/system-requirements
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The 'File' menu gives users access to commonly used commands. 

New Create a new exhibition 

Open Open an existing exhibition 

Save Save the current exhibition  

Save As Save the current exhibition with a new name 

Load Space Load a gallery space 

CMS 
Import 

Import artworks and associated textual information from your CMS via a .csv (comma 
separated) file 

Screenshot Take a screenshot of the current view in the work area 

Exit Exit Ortelia Curator 

 

The 'Edit' menu gives access to the 'Curate' panel and the 'Settings' panel 

Undo Undo the last action (Ctrl + z) 

Redo Redo the last action (Ctrl + y) 

 

The 'Display' menu allows users to turn displayed items within the gallery on/off by checking or un-
checking items in this drop-down list.  

2D Artwork Show/Hide 2D artwork 

3D Artwork Show/Hide 3D artwork 

Media Art Show/Hide Media artworks 

Didactics Show/Hide Didactic panels 

Lights Show/Hide lights 

Measurements Show/Hide measurements 

Notations Show/Hide Notations 
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The 'Settings' menu gives access to the 'Curate' panel and the 'Settings' panel 

Graphics Opens the Graphics Quality settings. Graphics quality is set to medium with shadows on by 
default. Improve performance by turning shadows off and reducing graphics quality. 

Units Change between metric and imperial units of measurements 

 

The 'Help' menu gives access to the 'Curate' panel and the 'Settings' panel 

Quick Start Guide Opens the Quick Start Guide 

User Manual Opens this help document as a PDF. 

Deactivate License Deactivate your license. 

Web Go to the Ortelia website 

About Application credits and version number 

 

The Curate Work panel 
The 'Curate' work panel is divided into six individual tabs that allow access to categorised functionality. 
The work panel tabs are summarised below: 

 

2D Artwork Tools for importing and placing 2D artworks 

Frames Tools for framing 2D artwork 

3D Artwork Tools for importing and placing 3D artworks 

Media Art Tools for importing and placing video and sound files 

Plinths Tools for creating and placing Plinths 

Didactics Tools for creating and editing didactic panels 

Lights Tools for creating, placing and modifying lights 

Gallery Tools for painting walls, setting hanging lines, taking 
measurements, adding notes etc. 
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The Curate work panel in detail 

The 2D Artwork Tab 
The 2D artwork tab allows users to import and place 2D artwork in the gallery. 

  

  

 

 

 

 

 

The 3D Artwork Tab 
The 3D artwork tab allows users to import and place 3D artwork in the gallery 

Import 3D Import a 3D artwork (Collada .dae format) 

Import Sprite Import an image to use as a billboard in place of a 3D 
artwork 

Delete Delete a 3D artwork or sprite from the 'Artworks' list 

Place Place a 3D artwork or sprite on a surface 

Remove Remove a 3D artwork or sprite from an exhibition 

 

Import Import a single 2D (single image) artwork 

Import Folder Import a folder of artworks (multiple images) 

Delete Delete an artwork from the list 

Place Place an artwork on a wall or surface 

Edit Crop an artwork image 

Remove Remove a selected artwork from the current exhibition 

Goto Jump to a selected artwork in the gallery by selecting it 
from the 'Artworks' list 

Width Set the width (in mm) of the image selected in the list 

Height Set the height  (in mm) of the image selected in the list 
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Goto Jump to a selected 3D artwork in the gallery by 
selecting it from the 'artworks' list 

Edit Edit a sprite 

Orientation Set the orientation of the selected 3D artwork 

Scale Change the scale of the selected 3D artwork or sprite 

  

 

 

The Media Art Tab 
The Media Art tab allows users to import and place video and sound 

 

Place Place a Projector, Monitor, Television, or Speaker in 
the gallery 

Remove Remove a Projector, Monitor, Television, or Speaker 
from the gallery 

Goto Jump to a selected video or sound in the gallery by 
selecting it from the 'artworks' list 

Aim Aim the projected video at a surface 

Type Select from the available display devices such as 
Television, Computer Monitor, Projection, or speaker 

Aspect Set the Aspect ratio of a television, computer monitor 
or projection 

Size Set the size of the television screen or monitor 

Volume Adjust the volume of the video or sound 

Angle Set the throw angle of a projection 

Orientation Set the Orientation of a projection or Television screen 

Artworks List of imported video and sound files 

Sound Sources List of sound sources (Speakers) currently in the design. 

Import Import a video or sound file 

Delete Delete a selected video or sound file from the artworks  
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The Plinths Tab 
The Plinths tab allows the creation and placement of Plinths in the gallery 

 

Place Place a Plinth in the gallery space 

Remove Remove a Plinth in the gallery space 

Goto Jump to a selected plinth in the gallery by selecting it 
from the 'Plinths' list 

L, W, H. Set the Length, Width and Height of the Plinth 

Orientation Rotate the plinth about a 360° axis 

Save/Flood Save a Plinth colour and paint all plinths in the gallery 
with the same colour 

Plinths List The list of Plinths in the exhibition 

Create Plinth Create a new Plinth 

Delete Delete a Plinth from the list 

 

The Didactics Tab 
The Didactics tab allows users to create, edit and delete didactic panels 

 

New Create a new didactic panel 

Delete Delete a selected didactic panel from the list 

Replace Image Add a user loaded image to the panel 

Remove Image Removed a user loaded image from the panel 

Import Folder Import a folder of images as panels 

Place Place a didactic panel on a surface 

Edit Edit an existing didactic panel 

Remove Remove a didactic panel from the exhibition  

Goto Jump to a selected didactic panel in the gallery by 
selecting it from the 'Didactic Panels' list 

Width Set the width (in mm) of the selected didactic panel 

Height Set the height (in mm) of the selected didactic panel 
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The Gallery Tab 
The Gallery tab gives users access to a variety of functions such as wall painting, notations and 
measurements 

 

 

 

 

 

 

 

 

 

 

 

  

 

Time of Day Set the time of day to test shadow and light effects 

Eye Line Turn Eye Line(Hanging height)  on/off  

Snap Snap artworks to the Eye Line when placing artworks 

Height Set the Eye Line height from the base of the hanging 
surface (e.g. wall) 

Wall ID: Turn wall ID's on and off  

Colour Select a colour to paint the wall 

Save Save the current wall colour 

Flood Paint all the walls in the space with the saved colour 

Elevation Generate elevations of a wall with artwork 
information 

Measurements: 
Create/Delete 

Create and delete a distance measure 

Notations: create Create a notation to place in the environment 
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The Lights Tab 
The Gallery tab gives users access to a variety of advanced lighting functions. 

The Frames Tab 
The Frames tab allows users to frame artwork with a variety of framing options. 

 

Create Create a new light 

Place Place a light on a surface 

Aim Aim the selected light 

Delete Delete the selected light 

Type Select the light type 

Angle Set the cone angle of the selected light 

Intensity Set the intensity (brightness) of the selected light 

Focus Set the focus of the selected light 

Rotation Rotate the selected light on its Z axis 

Save Save the selected light colour 

Flood Flood all the lights in the exhibition with the selected 
colour 

Light Colour Select the light colour 

Ambient Set the level of ambient light in the gallery 

Shutters barn 
doors Side 

Change which shutter to modify 

Position The position of the shutter 

Rotation The rotation of the shutter 

 

Frame Check to frame the selected painting 

Width Set the width of the frame 

Inner Set the inner width of the backing panel 

Frame Colour Select the colour f the frame and backing panel 

Save Save the selected colour 

Flood Paint all frames the saved colour  

Colour Value  



 

Ortelia Interactive Spaces Copyright 2017 
 

19 

The Gallery Workspace 
The Gallery Work Space is where users can curate an exhibition. All aspects of curating an exhibition are 

carried out within this 3D workspace.  The selected gallery space is displayed and users navigate within 

the space to place artworks, didactics, lights etc. 

 

The Gallery Work Space 

  

Gallery Work Space 

 The panel can be hidden 
by clicking this tab with 

the LMB 
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Keyboard functions and Navigating 
There are a number of methods for interacting and moving around inside the Ortelia Curator™ 3D 
environment. 

A combination of keystrokes and mouse buttons can be used to navigate. 

Keyboard functions (Directional Keys) 
Both the arrow keys and the W, S, A, D keys can be used as directional keys to move around the 
environment. 

 

Arrow keys allow the following movement: 
Forward (Up arrow, Backwards (Down Arrow), Left (Left arrow) and Right 
(Right Arrow) 

 

W, S, A, D  keys allow the following movement: 
Forward (W key), Backwards (S Key), Left (A Key) and Right (D Key) 

 

Mouse Functions (Selecting objects, looking around) 
 

The mouse buttons serve various functions. 

 

• Left Mouse Button (LMB) – This button is the 
action button. You can use it to select objects in 
the exhibition and complete input actions such as 
check boxes. 

• Right Mouse Button (RMB) – This button is used 
to rotate about the environment. Hold the RMB 
down and then move your mouse sideways to 
rotate about. Use this in combination with the 
direction keys to move freely around the 
environment. For example, you can simply use the 
forward and backward directional keys to move in 
those directions while holding down the RMB to 
steer.  
 
Note: This is a very effective and efficient way to 

navigate the 3D environment. 

Hint: You can travel faster through the 3D environment 

by holding down the 'SHIFT' key while moving. 

 

 
 
 

LMB RMB 
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Moving and Turning 
 
Use either the arrow keys or the W,S,A,D keys to move forward, backwards or pan sideways. Use the 
RMB in combination with the directional keys to turn corners and look around. The figure below 
demonstrates moving forward in the 3D environment while using the mouse to steer. 
 
 

OR  
+ 

 
Hold down either the Up Arrow key or the W 

key 
and  

Hold down the Right Mouse Button while 
moving the mouse sideways 
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Importing and Editing Artwork 
Ortelia Curator is designed to import and display both 2D (images) and 3D (geometric models) artworks. 

Importing 2D artwork 
Images can be imported either individually or as a group in a folder. Currently Ortelia Curator supports 
the following formats. 
 

Format File Extension 

JPEG .jpg 

TARGA .tga 

Windows Bitmap .bmp 

 
Importing images for an exhibition is carried out through the '2D Artwork' tab.  

 
To import a single image, click the 'Import' button located at on the bottom left 
hand side of the tab. A 'Open' dialogue box will appear and you can navigate to 
the folder where the image you want is located. In the 'Open' dialogue select 
the format of image you want to import from the dropdown box of formats.  
Select the image and click 'Open' to continue. The image will be shown in the 
'Artworks' List. 
 
To import multiple images, either selected import and choose multiple 
artworks by holding the shift key, or gather all the required images in a single 
folder andclick the 'Import Folder' button located on the bottom right-hand 
corner of the 2D Artwork Tab. A dialogue box will appear and you can navigate 
to the folder where the images you require are located. . In the 'Open' dialogue 
select the format of image you want to import from the dropdown box of 
formats. 
Select the first image in the list and click 'Open'. The artwork will begin 
importing. Depending on your hardware this may take some time.  

When the images have been imported they will appear in the 'Artwork' list. 
Artwork can be removed from the Artwork list by selecting the image from the list and then clicking the 
Delete button 
 

 
 
Note: Ortelia Curator embeds all images into a single file in order that images cannot be extracted from the save 

file. As such, the final size of a save file will depend on the number and size of images imported.  
It is recommended that images are kept to a maximum of 2048 pixels and saved as JPEG format in order to 
maintain and reasonable overall final save file size. 
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Editing 2D Artwork 
 
There are two basic editing options available. These are: 
 

I. Setting the physical dimensions of the artwork 
II. Cropping the artwork 

To set the physical dimensions select the artwork from the list by clicking on it with the LMB. Enter the 
width and height in mm of the selected artwork.  
 

 
 
In some instances you may need to crop an image to remove unwanted elements.  
Select the image you want to crop from the "Artwork' list.  
Click the 'Edit' button. 
 

 
 
The image will appear in the 'Crop Image' window.  
The corners of the red box can be dragged to the new position. 
When cropping is complete click the 'Finish' button to return to the 3D environment.  
To reset the cropping borders to their original position click the 'Reset' button with the LMB 
 
In the following example we have photograph that must be cropped to in order to remove some of the 
foreground and background. 
 

 

Crosshairs on each corner can be selected by clicking and 
holding the LMB.  Corners can then be draged to the desired 
position 
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Lines have now been drawn to the very edges of the 
photograph. 

 

The cropped image is now displayed. 

 

Importing 3D Artwork 
Ortelia Curator currently only supports Collada (.dae) 3D geometry format. In addition to 3D geometry 
Ortelia Curator allows you to import an image (Sprite)in place of an actual 3D file. 
The '3D Artwork' tab provides the necessary tools for importing and manipulation 3D artwork and 
sprites. 
 

1. To import a 3D object or sprite, click on the 'Import' button at the 

bottom of the tab.  

2. A 'Open' dialogue box will appear and you can navigate to the folder 

where the 3D model or sprite image is located.  

3. Select the 3D model or sprite and click 'Open' to continue.  

4. You can continue to import as many models or sprite images as 

required.  

5. The artwork name will appear in the 'Artworks' list. 

6. To remove a 3D artwork or sprite from the list, select the item to be 

removed and click the 'Delete' button located at the bottom of the tab. 

For more detail on how to manipulate 3D models and Sprites in the work area and refer to the Placing 

and Manipulating 3D Artwork section 

 

  

https://collada.org/
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Workflow 
The following section describes the tools used to curate an exhibition 

Setting up the Gallery 

Loading and Importing Galleries 
Ortelia Curator comes pre-loaded with a default gallery. The first time you open the application the 
default gallery work environment will be displayed. If you have your own gallery it can be loaded using 
the command 'Load Space' from the 'File' drop-down menu. 

Click 'Load Space'.  A dialogue box will appear listing the available galleries. 
Select your gallery and click the 'Load' button. 
To import a new gallery follow the procedure above to open the 'Load Gallery' 
dialogue box.  
Click the 'Import' button if you have an Ortelia gallery file. A 'Open' dialogue 
box will appear and you can navigate to where your new gallery is located.  
Select the gallery and click 'Open' to continue.  
 

Note: The 'Import' routine does not import the external gallery space to the 'Gallery' list. You will need to import 

the gallery each time you want to use it. (To add a gallery to your list of galleries refer to the Appendixl.) 
 

The Gallery tab provides a variety of functions for setting up your gallery for 
an exhibition. 

Setting the Time of Day 
If your gallery has windows or entrances to the outside the 'Time of Day' 
function is useful for testing the effects of incoming light and the resulting 
shadows. The geographic location of the gallery is embedded the gallery 
model and the time of day slider will take this into account.  
 
 
 
 
 
 
 
 

In the following example four separate times are tested. 
 

  
6am 8am 
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Midday 6pm 

   Testing Shadows 

Setting the Hanging Height 
The desired hanging height (eye-line) for an exhibition can be set by checking the 'Eye Line' checkbox. 
The height of the eye line from the bottom of the wall can be adjusted by entering a value in 
millimeters. By checking the 'Snap' checkbox artwork will snap to the eye line when placed on a wall. 

 

When the 'Eye Line' checkbox is enabled, a line, set to the desired height from the floor will appear 
throughout the entire gallery. 

 

The Eye Line 

This line can be turned off by un-checking the 'Eye Line' checkbox. 

Wall ID 
Embedded wall identification numbers can be turned on and off by clicking on the 'Wall ID' check box 
with the LMB. The example below shows the wall ID. 

Eye Line 
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Wall Id displayed by checking the 'Wall ID' checkbox 

Painting Walls 
The wall painting dialogue section of the Gallery tab provides functionality for 'painting' walls in the 
gallery. 

Note: To paint a wall the 'Gallery' tab must be active.  

Painting is carried out by clicking on a wall of interest and then choosing 
the colour from the colour palette.  

I. Select a colour from the colour bar by clicking and  dragging the 
slider with the LMB.  

 

 

 

II. Once a colour is selected from the colour bar shades of the selected colour can be selected 
within the colour shade display by clicking and dragging the LMB. 

III. The wall will change colour to reflect your choice. 

IV. To save a colour and apply to other surfaces individually, click the 'Save' button. The saved 
colour will appear in the 'Saved Colour' box. 

V. Click on the surface you wish to paint with the LMD then click on the 'Saved Colour' box. The 
selected surface will change colour to reflect your changes 

  

Colour Shades 
Colour selection bar Current selected Colour 

Saved Colour 
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Painted Wall 

To paint all the walls in the gallery with a single colour select the colour you want to use, save it and 
then click on the 'Flood' button. All the paintable surfaces in the gallery will be painted with the selected 
colour. 
You can select a painted surface at any time and change the colour following the procedure above. 
Note: Make sure to save changes regularly 

Generating and Exporting Elevations (Pro version only) 
Elevations of individual walls with artworks can be generated and exported to PDF files.  
To create and export elevations for a complete exhibition: 
 

I. Select a wall by clicking on it with the LMB (Note: you will need to have the 'Gallery tab enabled)  

II. The wall will be outlined in yellow as in the example below. 

 

 
A highlighted wall 

III. Click on the 'Elevations' button with you LMB 

IV. The selected elevation for the selected wall will be displayed in a pop-up panel along with 
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relevant information such as: Wall ID, Wall Colour, Artwork Placement and an artwork list. 

 
The Elevations window 

V. In addition to the details listed above you can also choose to display the actual artwork images 
and wall colour in your exported elevations report. To do so click on the ‘Display artwork colour’ 
and Display wall colour’ checkboxes with the LMB. 

 
VI. Click the 'Export All' button to create a PDF file of all the wall elevations. 
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Measuring Distances 
The distance measuring functionality of the Gallery tab allows users to measure distances within the 

gallery space. Measurements are stored in the saved exhibition file.  

I. To measure a distance click on the 'Create' button in the 'Measurements' section of the Gallery 
tab. 

II. A red box with a crosshair inside will appear attached 
 to your mouse pointer.  

III. Click on the first point of your measurement with the 
 LMB. 

IV. Move the mouse to the end point of the measurement.  
    As you move the mouse the distance from the starting   
    point (in mm) will be displayed. 

V. Click again with the LMB to complete the measurement. 
 

The following example illustrates the process of creating a measurement. 

 

Click the first point of 

the measurement 

using the LMB 

 

Move the mouse to the 

end point of the 

measurement and 

finish by clicking with 

the LMB 
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The completed 

measurement showing 

the distance in mm. 

To delete a measurement: 

I. Select the measurement you want to delete with the LMB. 
II. The measurement line will turn red when selected. 

III. Click the 'Delete' button in the measurements section.  

Creating and editing Notations 
The notation functionality of the Gallery tab allows users to add notes within the gallery space. 

Notations are stored in the saved exhibition file.  

To create a notation: 

I. Click the 'Create' button in the 'Notations' section of the 
 Gallery tab. 

II. Click with the LMB on point you want to place the 
 notation. 

III. A notation icon will be placed where you clicked . 
IV. To add notes or access a note click the notation icon with your LMB 
V. The Notation panel will appear. 

VI. Type your notes in the text area of the notation  panel. 
VII. Click 'Save' to finish adding text and close the  window. 

To delete a notation: 

I. Click on the icon of the relevant notation. 
II. The Notation Panel will open. 

III. Click the 'Delete' button. The notation will be  removed from 
the exhibition. 
Note: Make sure to save changes regularly 
 

 

The Notation Panel 
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Placing and manipulating 2D and 3D artwork 
Ortelia Curator uses drag and drop functionality to place artworks. To place artworks, you must have 

either the '2D Artwork' or '3D Artwork' tab enabled.  

Placing 2D Artwork 
 

I. Select the artwork to place from the list by clicking on it with the LMB. 

II. Click the 'Place' button, alternatively, select the artwork and press the ‘p’ key.  

III. Move the mouse into the gallery area. The art work is now attached to your mouse pointer and 

will track the surfaces that you move over. The distances (in mm) from the centre of the artwork 

to the floor, ceiling and walls are displayed in real-time as the artwork is moved. 

IV. Click again with the LMB to place the artwork. 

V. To remove an artwork from the gallery space, select it and click the 'Remove' button 

 

Repeat this procedure for as many artworks as your require. 

Note: You can continue to navigate and look around while placing artwork by holding down the RMB 

and moving in the direction you wish to go. 

The following example illustrates the procedure outlined above. 

  

1. Select an artwork in the list 2. Drag the artwork to where you want it and click with 
the LMB to place 
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Artwork position can also be fine-tuned using the artwork nudge tool. To fine tune the position of the 

artwork on the wall: 

I.  Select it by clicking with the LMB. (Remember to have  the '2D Artwork' tab selected. 

II. The selected artwork will now show the measurement  lines and the nudge arrows. 

III. Click the nudge arrows with your LMB 
to move the  artwork in small increments. 

Note: Make sure to save changes regularly 
  

3. Select another artwork 4. Place the artwork 
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Placing 3D Artwork 
To place 3D artworks in an exhibition you must have the '3D Artwork' tab selected. Refer to the 
‘Importing 3D Artwork’ section for instructions on importing 3D artworks. 
 

I. Select the artwork to place from the list by clicking on it with the LMB. 

II. Click the 'Place' button.  

III. Move the mouse into the gallery area. The 3D artwork is now attached to your mouse pointer 

and will track the surfaces that you move over. 

IV. Click again with the LMB to place the artwork. 

V. To make fine adjustments to the position of the placed artwork click on the nudge arrows with 

the LMB to move in small increments 

VI. To remove an artwork from the gallery space. Select it and click the 'Remove' button 

Note: You can continue to navigate and look around while placing artwork by holding down the RMB 

and moving in the direction you wish to go. 

The following example illustrates the procedure outlined above. 

 
 

1. Select a 3D artwork from the list and click 'Place' 2. Continue to add artworks 

3D artworks can also be rotated and scaled after being positioned. 

Select the artwork in the exhibition space by clicking with the LMB. The relevant selected artwork will be 
highlighted in the tab list. The 'Orientation' slider will now be enabled in the 3D Artwork tab. 

Drag the slider to rotate the 3D artwork to the orientation 

required. 

Drag the ‘Scale’ slider to uniformly scale the 3D artwork up 

or down. 

Click the 'Goto' button to go to the selected artwork 

Using Sprites 
Sprites can be used in place of a 3D artwork. A sprite is simply an image that can be used as a 

representation of an actual 3D artwork.  
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Select the image you want to crop from the "Artwork' list.  

I. Click the 'Edit' button  

II. The ‘Edit sprite’ window will appear with the selected image displayed. 

III. To mask out the background of the image click on the ‘Create mask points’ button. 

IV. The cursor will now become a crosshair and you can begin adding points around your object as 

in the example below. Note – you can RMB click to remove an unwanted or incorrectly placed 

point. 

V. Continue around your object adding points till it is surrounded 

VI. Press ‘Enter’ key to complete or the ‘Esc’ key to abort the mask at any time. 

VII. Set the ‘Length’, ‘Height’ and ‘Width’ inputs to the objects real-world size. 

VIII. When complete click the ‘Finish’ button 

The Sprite can now be added to your exhibition following the same procedure as regular 3D artworks. 

The following images illustrate the procedure outlined above. 

  
1. Add the first point to start creating the mask 2. Trace the outline of the objects by adding 

points 
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3. Continue adding points till the object is 

outlined 

4. When completed set the dimensions of the 

object and click ‘Finish’ 
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Importing and Placing Video and Sound 
Ortelia Curator can import most Video and sound file formats. When importing a video or sound file only 

the first minute of the file is used in the exhibition. This is done to minimise the size of the final saved 

file.  

Importing Video and Sound 
To import video and sound files the 'Media Art' tab must be enabled. The following steps describe the 

process of importing video  and sound files. 

1. Click on the 'Import' button with the LMB 

2. Navigate to the folder containing your video or audio file. 

3. Select the file and click 'Open' 

4. A dialogue box will appear while your file is imported.  The 

 time it takes to import a file will be dependent on your 

 hardware. 

5. Imported files will appear in the 'Artworks List' 

 

Placing Video and Sound. 
Placing digital artwork is the same process as that for placing 2D and 3D artwork. The following steps 

describe the process of placing and manipulating digital artwork. 

1. Select an artwork from the list by clicking on it with the LMB 

2. Depending on whether you are placing video or sound, choose 

 between, Television, Monitor, Projector or Speaker from the 'Type' 

Dropdown list. 

3. If choosing video, select the Aspect Ratio you would like the display 

 to be from the dropdown list. 

4. Click the 'Place' button and move your cursor into the work area. 

5. Click again with the LMB to place the video or sound. 

6. Adjust the angle of projected video using the 'Angle' Slider 

7. Adjust volume of either audio or video files with the 'Volume'  Slider 

8. Change the orientation of a Television, Monitor, Projection or Speaker 

with the 'Orientation' slider. 
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Place a projector where you want it in the gallery space 

by clicking with the LMB. Projectors can be placed on 

any surface 

 

Aim the projection where you want it.  

Note: Depending on your placement and aiming of the 

projector the resulting video may be distorted due to the 

angle of the projection. In this case place the projector 

in another location or on a plinth as shown 

 

Change Aspect/Ratio of the projection using the 'Aspect' 

drop-down menu 

'  

Change the width and height of the projection using the 

'Angle' slider 
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Add video as using a computer monitor.  

 

Change the size of a computer monitor or Television 

using the 'Size' input box. Size of screen is defined in 

inches.  

Change aspect/ration of a computer monitor or 

television using the 'Aspect' drop-down menu 

 

Place a Television screen on a wall or any other surface.  

Set the size and aspect from the relevant drop-down 

menus. 

 

Select a sound file and ‘Speaker’ from the drop-down 

menu. Place your speaker where you want it. 

To add additional speakers around your space - Select a 

sound media file from the list and click ‘Add Source’. 

Select the added source and place it where you want it.  
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Creating and Placing Plinths 
Creating and placing plinths uses the same workflow as that described in previous sections. The 

following steps describe the process of creating and placing Plinths. 

Creating a Plinth 
To create plinths the 'Plinths' tab must be enabled. 

1. Click on the 'Create Plinth' Button with the LMB 

2. A plinth will appear in the 'Plinths' List.  

3. Set the Length, Width, and Height (in mm) using the input boxes. 

4. Choose a colour for the selected plinth using the Colour box and bar. 

5. To delete a plinth from the list select it it in the list and click the  'Delete'  

 button. 

 

Placing Plinths 
 

 

 

 

 

 

 

To place a plinth: 

1. Select the plinth from the list by clicking on it. 

2. Click the 'Place' button. 

3. Move the mouse cursor into the gallery space, the plinth will be attached to your cursor. The 

distance from each wall to the centre of the plinth will be dynamically displayed. 

4. Click on the surface where you would like to place the plinth. 

5. Adjust the orientation of the plinth using the 'Orientation' slider. 

6. To remove a plinth from the gallery, click the 'Remove' button 
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Plinths can also be used to create other useful elements such as shelves, temporary walls or partitions 
and posts for ‘hanging’ a ceiling projector. The following images illustrate the additional uses for a 
plinth. 
 

 

Shelves created from plinths 

 

A plinth is used as a post to ‘hang’ a projector 
from the ceiling 

 

A plinth is used as a temporary partition. The 
plinth can be used to hang artwork. 
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Creating and Editing Didactic Panels 
Selecting the 'Didactics' tab allows users to create add didactic panels within the gallery space. Didactic 
panels are stored in the saved exhibition file.  

To create a didactic panel, click 'New' at the bottom of the tab.  
A new didactic panel will appear in the 'Didactic Panels' list 
In order to enter didactic information, the didactic panel needs to be placed in the gallery. 

 

To place a didactic panel 

I. Select the required didactic panel to place from the list.  

II. Click the 'Place' button.  

III. Move the mouse into the gallery area. The didactic panel is 

now attached to your mouse pointer and will track the 

surfaces that you move over. 

IV. Click again with the LMB to place the didactic panel. 

V. To edit the didactic panel and enter text, select the panel in 

the list and click 'Edit' 

VI. The didactic panel will open and you can enter text.  

VII. To finish editing click the 'Finish' button in the Didactics tab. 

 
To remove a didactic panel from the gallery space, select it and click the 'Remove' button 
To delete a didactic panel from the list, select the panel and click 'Delete' 
The following example illustrates the procedure detailed above. 
 

  
1. Create a new empty didactic panel 2. Place the new didactic panel 
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3. Click 'Edit' enter or modify text 4. Enter or edit text and click 'Finish' to complete 

 

 

5. The new didactic panel  

Note: Make sure to save changes regularly 
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Creating and Editing Frames 
There are situations where you may want to experiment with framing options. Ortelia Curator provides 

functionality to test framing options. 

Enabling the 'Frames' tab allows users to create and add frames to artwork within the gallery space. 
Framed artworks are stored in the saved exhibition file.  

To Frame an artwork first select it in the '2D Artwork' tab. 

 

I. Switch to the 'Frames' tab. 

II. Check the 'Frame' checkbox. 

III. Enter the width (in mm) of the outer frame. 

IV. Enter the width (in mm) of the inner picture framing mat 

(inner) 

V. To colour either the Outer Frame or the Inner mat select the 

frame  type from the 'Colour' dropdown and then select a 

colour from the  Colour bar and Colour shade areas. 

VI. Select a colour from the colour bar by clicking and dragging the 

 slider with the LMB.  

VII. Once a colour is selected from the colour bar shades of the 

selected  colour can be selected within the colour shade 

display by clicking and dragging the LMB. 

VIII. The frame will change colour to reflect your choice. 

IX. To save a colour and apply to other frames individually, click 

the 'Save' button. The saved colour will appear in the 'Saved 

Colour' box. 

X. Select the frame you wish to colour then click on the 'Saved 

Colour' box.  

 

The following sequence illustrates the procedure outlined above. 

 

Select the artwork to be frames in the '2D Artwork' 

tab 

Colour Shades 

Colour bar 

Colour shades 
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Open the 'Frames' Tab and select the 'Inner' and 

'Outer' frame widths (in mm) 

 

Choose the colour of the inner and outer frames 
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Lighting 
The following section describes the tools used to create and manipulate lights 

Creating and Adding Lights 
Selecting the 'Lights' tab allows users to create add lights within the gallery space. Lights are stored in 
the saved exhibition file.  

I. To create a light click the 'Create' button. 

II. Move the mouse cursor into the gallery environment. The light will 
 be attached to the mouse pointer. 

III. Click with the LMB where you would like to place the light.  

IV. Move the mouse pointer to the point you want your light to aim to. 
 You will notice that the light now follows the mouse. 

V. Click on the point you want the light to aim at with the LMB. 

You can now adjust the Angle of the light cone, the intensity of the light and 
the focus of the light. 

You can also change light colour. 

Note: A light that is highlighted in red is the active light you are working on. 

To select a light click on it with the LMB. 

The following image sequence illustrates the procedure outlined above. 

  

1. Click the 'Create’ button 2. To place the light click with the LMB 
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3. Click with the LMB to set the aim point of the light 4. Adjust the cone angle of the light 

  

5. Adjust the intensity of the light 6. Adjust the focus of the light. 

 

Note: Lights are computationally expensive. The number of lights you can have in one exhibition will depend on the 

graphics card hardware you have. Refer to the recommended hardware section of this manual. If you are 
experiencing performance issues as you add lights it is recommended that you reduce the graphics quality and turn 
off shadows in the 'Settings' menu. 

Ambient Gallery Light 
The ambient light of the gallery can be adjusted using the 'Ambient' slider at the bottom of the Lights 
tab.  
 

To adjust the ambient light of the gallery, click on the slider with the LMB 
and drag it to a level of ambience required. 
 

  
Low Ambient Light High Ambient Light 
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Editing Lights and Mixing Light Colours 
The lighting functionality in Ortelia Curator allows you to colour lights in an infinite combination. In 

addition, the light controls allow for a high degree of variability. This section describes how to edit light 

parameters and mix light colours. 

In all the examples described below are light has been placed on one wall and aimed at the adjacent 

wall as shown in the example below. 

 

Cone Angle 
Cone angle of lights can be adjusted using the 'Angle' slider. 

Note: As the cone angle increases the intensity of light will drop off as the light is spread over a greater area. 

   

Increasing cone angle 

 

Light Source Light aim point 
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Light Intensity 
Intensity (brightness) of lights can be adjusted using the 'Intensity' slider. 

Note: As the brightness increases the soft edges of light will sharpen. 

   

Increasing light intensity (Brightness) 

 

Light Focus 
Focus (sharpness) of lights can be adjusted using the 'Focus' slider. 

Note: As the focus increases the soft edges of light will sharpen. 

   

Increasing light focus 
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Colour Mixing 
Lights can be used to mix colours.  

Note: The amount of overlap between lights of different colours combined with Angle, Intensity and 

Focus will influence the colours and tones generated when mixing different coloured lights. 

   

The effects of colour overlap and decreasing ambient light 
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Appendix 
 

Adding a external gallery to the Gallery List 
There may be instances where you need to add an external gallery file created in Ortelia Space builder 

to your list of saved galleries. The following steps will guide you through the process. 

1. Locate the gallery file you would like to add. The extension will be .ocs, for example, 

MyGallery.ocs. 

2. You need to copy this gallery file to the Ortelia Curator 'Spaces'. Typically, this will be:  

a. C:\Users\Your Username\Documents\Ortelia\Curator\Spaces – Windows 

b. Users/Username/Documents/Ortelia/Curator/Spaces – Macintosh 

3. The next time you start Ortelia Curator your gallery will appear in the list. 

IT Readiness 
System Requirements: 
Tested Operating Systems: 

• Microsoft Windows XP 
• Microsoft Vista 
• Microsoft Windows 7 
• Microsoft Windows 10 
• Macintosh OSX  

Linux systems are not currently supported 
 
Hardware: 
• Recommended minimum of 4gb of RAM 
• Intel Core 2 Dual or Quad Core processor or above 
• Direct X 9.0c (or above) capable graphics card 
Important Note 
Ortelia Curator requires a graphics card that supports at least Shader model 3.0 to display correctly. The 
following graphics cards are a minimum specification required to run Ortelia Curator.: 
• ATI Radeon HD 3800 Series and above 
• NVIDIA GeForce 8 Series and above 
Note: While we do recommend that users have a standalone graphics card, curator will still run 
acceptably well on most integrated graphics chipsets, however the use of gallery lights will be limited 
and some performance impacts may be experienced. 
 
License Activation 
 
Please note that an internet connection is required to activate an Ortelia Curator license.  When 
attempting to activate on a computer that is blocked by a firewall the license activation will fail. 
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Remote Installation 
 
Curator does not require any registry files to run, so once it is installed on one machine it can simply be 
‘copied’ across a network to other machines if so desired (licenses will need to be activated of course).   
At request we can provide a custom installer with Direct X stripped, or other custom installers if 
required.  Please contact us if you have any queries. 
support@orteliacurator.com 

Glossary 
Sprite - A sprite is a two-dimensional image that always faces the viewer. A sprite image can be in any 

format that Ortelia Curator accepts. It can be used in place of a 3D artwork. 

 

Help and Support 
 
Support Options: 
Website:  http://ortelia.com/orteliacurator/ 
Email:    support@ortelia.com 
User Forums: http://ortelia.com/Forums/ 
 
 
Please allow 24 hours for support requests to be answered. 
 
Contact Details: 
Ortelia Interactive Spaces 
PO Box 3129 
Newmarket , 4051 
Queensland  
Australia 
 
 
 
 
 
 
 

http://ortelia.com/VC
mailto:support@ortelia.com?subject=Ortelia%20Curator%20Support
http://ortelia.com/Forums/
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